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NOTE: | HOPE NOT TO GET BOGGED
DOWN IN C++ ISSUES .. THIS IS NOT
A WEBINAR ON HOW TO PROGRAM!



Traditional Finite Element
Software

« Commercial fe codes are large complex
software containing over one million lines of code.
They are closed-source but do allow new
element and material routines to be added. (at
least the serious ones do)

 They are slow to change as hardware changes
and they do not allow researchers to play with
other equally important aspects of the code.
They do not promote the active sharing of nhew
code.
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OpenSees Goals

*To use modern software techniques to evolve an extensible
finite element software platform for earthquake engineering that
would encompass both structural & geotechnical engineering
and be able to change with the rapidly changing hardware
resources.

*To provide a common analytical research framework for
researchers to educate students & share new knowledge.

*To foster a mechanism whereby new research could be
disseminated quickly to industry for testing and adoption.



OpenSees Classes

*To achieve these goals we developed an open-source
framework for the development of sequential and parallel
finite element applications. This framework we call OpenSees.

*The framework contains many classes provided by ourselves
and many many others that allows you to build finite element
applications.

One example of which is the interpreted finite element
application, OpenSees.exe.

Commands/Script

Output




FEM

OpenSees Abstract Classes

Element

I |

[

|
-\CHandler \Numberer| Com:;:sg;ence jdo':-tilt‘;:;x Integrator |S'ystem0qun
. . \DataOutputHandler| DataBase
Parz{llel&Dlstrlbute
Channel
MovableObject | jj | |
sendSelf(Channel, int)
recvSelf(Channel, int,..) TCp UDP MPI Database | ©@®
Reliability]
_ RandomVariable Random LimitState Spectru Filt Correlation Modulating
I Positioner Variable Function pectrum Her Cogfﬁcient Function
Elemen, l I
Probability Search Find MeritFunction
Transformation | | Direction DesignPoint Check
| | LV | StepSize
I | | I Rule
Gfun Find GradG RandomNumber
Evaluator Curvatures Evaluator Generator

Currently over 1000 classes (modules)!




THE ADVANTAGE OF A
SOFTWARE FRAMEWORK
SUCH AS OPENSEES IS THAT
YOU DON’T HAVE TO
UNDERSTAND ALLOFIT TO
BUILD APPLICATIONS OR
MAKE CONTRIBUTIONS
YOU JUST NEED TO
UNDERSTAND THAT PART
THAT CONCERNS YOU



OPENSEES FEM ABSTRACT

FEM

CLASSES

Convergence| | Solution
CHandler | Numberer Test Algorithm Integrator | SystemOfEqn
ataOutputHandler DataBase

Element Node | |MP Constraint| |SP_Constraint| | LoadPattern |—{ TimeSeries

Material

4 ElementalLoad| | NodalLoad | |SP_Constraint

I I |
Uniaxial nD Section




Framework Contains both Abstract

Classes & Concrete Subclasses

Elastic
ElasticPP
Hardening
Concrete
Steel
Hysteretic
PY-TZ-QZ
Parallel
Series
Gap
Fatigue

Elastic

]2
DruckerPrager
FluidSolidPorous

Elastic

Fiber <O

PressureMultiYield(dependent, independent)

(over 250 material classes)

Truss

ZeroLength
ElasticBeamColumn
ForceBeamColumn
DispBeamColumn
BeamWithHinges
Quad (many forms)
Shell

Brick(many forms)
Joint

Contact

Staticlntegrator
LoadControl
DispControl
ArcLength

TransientIntegrator
CentralDifference
Newmark

HHT
GeneralizedAlhpa
NewmarkExplicit
TRBDF2

AlphaOS

(>100 element classes) (>35 classes)



Unknown Class Type

When OpenSees.exe is running and it
comes across a class type it knows nothing
about BEFORE GIVING AN ERROR IT
WILL TRY AND LOAD A LIBRARY OF
THAT CLASSES NAME. If it cannot find

a library of the appropriate name or the

procedure of the appropriate name in the
library it will FAIL. [ Commands/script

Output




@™ Command Prompt

jﬁ;‘icroso{’t Windows [Uersion 6.1.760811]
{Copyright (c> 200? Microsoft Corporation. All rights reserved.

IC:\Users\PEER Center>cd DEVELOPER
C:\Users\PEER Center\DEUELOPER>cd material
;C:\Users\PEER Center\DEUVELOPER\material>cd cpp
fC:\UsePs\PEER Center\DEUELOPER\material\cpp>OpenSees Examplel.tcl
OpenSees — Open System For Earthquake Engineering Simulation
Pacific Earthquake Engineering Research Center — 2.3.2
(c> Copyright 1999.2008 The Regents of the University of California

All Rights Reserved
(Copyright and Disclaimer (@ http://uwuu.berkeley.edu/OpenSees/copyright._html)

WARNING could not create uniaxialMaterial ElasticPPcpp
while executing

J"uniaxialMaterial ElasticPPcpp 1 30600 68.601"
(file “Examplel.tcl" line 21>

IC:\Users\PEER Center\DEVELOPER\material\cpp>




To Add a New Class you must:

1) Provide Code that meets the Interface
of the appropriate super-class
2) you must BUILD THE LIBRARY

3) make it accessible to the program.

WHILE C++ IS THE GLUE LANGUAGE
THAT HOLDS OPENSEES TOGETHER

YOUR CODE DOES NOT HAVE TO BE
WRITTEN IN C++.

C and FORTRAN OPTIONS ARE ALSO
AVAILABLE




UniantialMarerial Interiaee

class UniaxialMaterial : public Material MuSt be Overrldden by
{ .
public: subclass, “pure virtual”

UniaxialMaterial (int tag, int classTagqg);
virtual ~UniaxialMaterial(); ‘(//

t setTrialStrain(double strain, double strainRate = 0.0
aal double

getStrain (void)
virtual double getStress(void)
virtual double getTangent(void) = 0;
virtual double getInitialtangent(void) =0;

= 0;
= 0;

virtual int commitState(void) = 0;
virtual int revertTolLastCommit (void) = O0;
virtual int revertToStart(void) = 0;

Can be overridden by subclass

vi taes a getCopy (void) = 0;

virtual Response *setResponse(const char **argv, int argc,OPS_Stream &theOutput);
virtual int getResponse(int responseID, Information &info);
virtual void Print(OPS_Stream &s, int flag =0);

virtual int sendSelf (int commitTag, Channel &theChannel)=0;
virtual int recvSelf (int commitTag, Chanel &theChannel, FEM ObjectBroker &theBroker)=0;
// THERE ARE SOME OTHERS .. BUT THESE ARE PURE VIRTUAL ONES THAT MUST BE PROVIDED
protected:
private:

};




Adding New Code

For those new to Programming NEVER EVER NEVER START
WITH AN EMPTY FILE .. TAKE SOMETHING SIMILAR THAT
WORKS AND MAKE CHANGES TO THAT FILE.

We provide C++, C and Fortran examples on-line using svn

svn://opensees.berkeley.edu/usr/local/svn/OpenSees/trunk/DEVELOPER

TortoiseSVN for Windows Users

%% Checkout '

%" DEVELOPER - Checkout - TortoiseSVN Finished! =
Repository
URL of repository: Action Path
svn://opensees.berkeley.edu/usr/local/svn/OpenSees/trunk/OpenSeesDeveloper Added C:\Users\PEER Center\DEVELOPER\material\c\example1.tcl
7 Added C:\Users\PEER Center\DEVELOPER\material\c\example2.tcl
Checkout dlrectob Added C:\Users\PEER Center\DEVELOPER\material\cpp
C:\Useye EKOPENSEESDEVFHOP@F Added C:\Users\PEER Center\DEVELOPER\material\cpp\ElasticPPcpp.cpp
Added C:\Users\PEER Center\DEVELOPER\material\cpp\ElasticPPcpp.h
Checkout Depth Added C::\Users'\PEER Center\DEVELOPER\materiaI\cpp\Makefile
Added C:\Users\PEER Center\DEVELOPER\material\cpp\examplel.tcl
[Fully recursive Added C:\Users\PEER Center\DEVELOPER\material\fortran
Added C:\Users\PEER Center\DEVELOPER\material\fortran\materialTypes.f
Omit externals Added C:\Users\PEER Center\DEVELOPER\material\fortran\materialAPLf
Added C:\Users\PEER Center\DEVELOPER\material\fortran\Makefile
Revision Added C:\Users\PEER Center\DEVELOPER\material\fortran\examplel.tcl
Added C:\Users\PEER Center\DEVELOPER\material\fortran\elasticPPf.f
O/ HEAD revision Added C:\Users\PEER Center\DEVELOPER\material\Makefile

- Completed At revision: 4760
Revision Show log

< I



Source Code Tree Iin
DEVELOPER

core integrator recorder

material

Makefile
Windowslnstructions
UnixInstructions

Trapezoidal.h I

C fortran cpp c fortral

Trapezoidal.cpp Cpp

element element...

ElasticPPcpp.h
ElasticPPcpp.cpp
example1.tcl

elasticPPc.c
example1.tcl

elasticPPf.f
example1.tcl
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Open ViualStudio

File —-> New Project

Give it name of New class and location of current class
ElasticPPCPP and C:\???\OpenSeesDeveloper\material

Select OK.

New windows pops up, Select Application Settins

Select DLL AND select Empty Project

Select Finish

a new project pops up in the workspace with class name
(ElasticPPCPP)
8. Right click on source files, select add Existing Item.

&% Find

a
$ac Replace

Editing

files

9. browse to the class file (should be up 1 directory, select it

(elasticPPcPP.cpp)

10.Right click on heared files, select add existing item.
11. browse to header file, select it (elasticOOCPP.h)

12. right click on Project (ElasticPPCPP), select build.

It fails in compilation, as cannot find file elementAPI.h

13. right click on Project (ElasticPPCPP), select Properties.

14. select c¢/C++ folder icon

15. In Configuration pull down menu, select all Configurations
16. Click 3 dots to right of Additional Include Directories

17. In window that pops up, select folder

18. add to line ..\..\core (this directory contains the
elementAPI.h file).

19. select ok.

20 right click on project (ElasticPPCPP), select build

It fails in Linking, a lot of unresolved external symbols.
21. Right click on source files, select add Existing Item.

22. browse to the core directory (should be 1 directory up)

23. select all the .cpp files here
24. right click on Project (ElasticPPCPP), select build.

IT SHOULD WORK! .. IF IT FAILS GET MY ATTENTION.

1
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Organize v Include in library v

4 . Favorites
B Desktop
'3 Downloads

~» Recent Places

4 7] Libraries
> .. Documents
> .4 Music
> ~_ Pictures
> !. Videos

> i-& Homeagroup

4 ‘& Computer
> & BOOTCAMP (C)

., » Computer » BOOTCAMP (C:) » Users » PEER Center » DEVELOPER »

New folder

-~

Share with ~ Burn

-~

Name

algorithm
core
element
integrator
material
recorder

system

1

corelist
makeCore
Makefile
Makefile

| UnixInstructions

Q0RO YOI

WindowsInstructions

Date modified

1/20/2012 4:13 PM
1/20/2012 4:13 PM
1/20/2012 4:13 PM
1/20/2012 413 PM
1/20/2012 4:13 PM
1/20/2012 413 PM
1/20/2012 4:13 PM
1/20/2012 4:13 PM
1/20/2012 4:13 PM
1/20/2012 4:13 PM
1/20/2012 4:13 PM
1/20/2012 413 PM
1/20/2012 4:13 PM

Type

File folder

File folder

File folder

File folder

File foider

File folder

File folder

File

TCL File

File

Export Definition F...
Text Document

Text Document

. . - -
@ Ov‘ ). » fmk » DEVELOPER » material » cpp
Organize ~ Include in library Share with ~ Burn New folder

. Favorites | Name Date modified Type Size

M Desktop &7 ElasticPPcpp 1/20/2012 413PM  C++ Source 7KB

'+ Downloads @) ElasticPPcpp 1/20/2012 413PM  C/C++ Header 4KB

«<» Recent Places &) examplel 1/20/2012 4:13PM  TCL File 2KB
@ Makefile 1/20/2012 413 PM  File 1KB

| Libraries
', Documents
4. Music
&, Pictures
& videos

1

Size

6 KB
1KB
1KB
1KB
1KB
2 KB

v
- —— e —



class ElasticPPcpp: public UniaxialMaterial {

public:
Material ElasticPPcpp(int tag, double e, double eyp);

ElasticPPcpp(); P -

Name ¢ cicPpepp(): material input properties
int setTrialStrain(double strain, double strainRate=0.0);
double getStrain(void);
double getStress(void);
double getTangent(void);
double getlnitialTangent(void);

int commitState(void);

int revertToLastCommit(void);

int revertToStart(void);

UniaxialMaterial *getCopy(void);

int sendSelf(int commitTag, Channel &theChannel);

int recvSelf(int commitTag, Channel &theChannel, FEM_ObjectBroker &theBroker);
void Print(OPS_Stream &s, int flag = 0);

private: data unique to
double fyp, fyn; // pos & neg yield stress terial i lud .
double ezero, E,ep; // init strain, elastic modma eral Includes.

double ep; // plastic strain at last commit Material parameters,

double trialStrain, trialStress, trialTangent; & State variables
double commitStrain, commitStress, commitTangent;

Intertace (i file)




Jiplemestatdon | 6pp (e

ElasticPPcpp::ElasticPPcpp(int tag, double e, double eyp)
:UniaxialMaterial(tag, 0),

ezero(0), E(e), ep(0.0) trialStrain(0.0),trialStress(0.0),trialTangent(e),
commitStreain(0.0),commitStress(0.0),commitTangent(e)

{
fyp=E*eyp;
fyn = -fyp;

}

ElasticPPcpp::ElasticPPcpp()

:UniaxialMaterial(tag, 0)

fyp(0).fyn(0),ezero(0), E(0),ep(0),

trialStrain(0.0),trialStress(0.0),trialTangent(0),

commitStrain(0.0),commitStress(0.0),commitTangent(e)

}
ElasticPPcpp::~ElasticPPcpp
{
// does nothing .. No memory to clean up
}
UniaxialMaterial *ElasticPPcpp::getCopy(void)
{

ElasticPPcpp *theCopy = new ElasticPPcpp(this->getTag(), E, fyp/E);
return theCopy;

I3
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Hardest Method to Write

ElasticPPcpp::setTrialStrain(double strain, double strainRate)

{

if (fabs(trialStrain - strain) < DBL_EPSILON)

return O;

trialStrain = strain;

double sigtrial; // trial stress

double f; /I yield function

/I compute trial stress

sigtrial = E * ( trialStrain - ezero - ep );

/I evaluate yield function

if ( sigtrial >= 0.0 )
f = sigtrial - fyp;

else
f= -sf%trlal + fyn;

double ieldSurface = - E * DBL_EPSILON;
if (f <= fYieldSurface ) {

/I elastic
trialStress = si trlal
trialTangent =

}ebe{
lastic
|f Si rlal>00){
trla tress = fyp;

} else é
trlal tress = fyn;

}triaITangent =0.0;

return O;

}




iplementation

double
ElasticPPcpp::getStrain(void)

{

return trialStrain;
}

double
ElasticPPcpp::getStress(void)

return trialStress;

}

double
ElasticPPcpp::getTangent(void)

{
}

int
ElasticPPcpp::revertToLastCommit(void)
{

return trialTangent;

trialStrain = commitStrain;
trialTangent = commitTangent;
trialStress = commitStress;

return O;

}




Ol |ifmoreter | 6 Hlel

OPS_Export void * Interpreter looking for this function in lib
OPS_ElasticPPcpp() ]
= { You can give yourself some

if (numElasticPPcpp ==0) {
opserr << "ElasticPPcpp unaxiz KUDOS! e-g- please reference

}numElasticPPcpp =1; ... if you used this
]

5 /] Pointer to a uniaxial material that will be returned
UniaxialMaterial *theMaterial = 0O;
5 int  iData[1];

double dDatal2];

int numData;

parse the script for
three material parameters
numData = 1;

if (OPS_GetiIntinput(&numData, iData) != 0) {
h opserr << "WARNING invalid uniaxialMaterial ElasticPP tag" << endIn;
return 0;
}
numData = 2;
if (OPS_GetDoublelnput(&numbData, dData) != 0) {
opserr << "WARNING invalid E & ep\n";
return 0; . ]
} Function returns new material

theMaterial = new ElasticPPcpp(iData[0], dData[0], dData[1]);

return theMaterial;




C & Fortran Procedural
Languages Can Also Be Used

OPS_Export void
elasticPPc (matObj *thisObj, SUBROUTINE ELASTICPPF(matObj,model,strain,tang,stress,is
modelState *model,
double *strain, IDECS IF DEFINED (_DLL)
double *tang, IDEC$ ATTRIBUTES DLLEXPORT :: ELASTICPPF
double *stress, IDECS$ END IF
int *isw, use materialTypes
int *result) use materialAPI
{ implicit none
*result = 0; IF (isw.eq.ISW_INIT) THEN
if (Yisw == ISW_INIT) { c getthe inputdata -tag? E? eyp?
double dDatal2]; numData =1
int iData[1]; iPtr=>iData;
/* get the input data - tag? E? & err = OPS_GetIntlnput(numData, iPtr)
int numData = 1; gg?:ia;%;j
OPS_GetlIntlnput(&numData, - ’
aumData = 2. put( err = OPS_GetDoublelnput(numData, dPtr)
OPS_GetDoublelnput(&nhumDy|
- putl c Allocate the element state
/* Allocate the element state * matObj%tag = idata(1)
e~ i~ . rAe matOhi%nnaram = 2




What Follows are the Steps
required to Build
ElasticPPcpp.dll on a
Windows Machine with
Visual Studio 2010 Installed



We Will Build the
ElasticPPcpp.dii

-
@Uv’ » fmk » DEVELOPER » material » cpp
Organize v Include in library v Share with v Burn New folder
Favorites - Name
B Desktop #] ElasticPPcpp
¢ Downloads @] ElasticPPcpp
«» Recent Places &' examplel
@ Makefile
_.| Libraries
Documents E
4. Music
. Pictures
8 videos

Source code and example are in
/IDEVELOPER/material/cpp
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1. Open ViualStudio

2. File -> New Project

3. Give it name of New class and location of current class files
(ElasticPPCPP and C:\???\OpenSeesDeveloper\material

4. Select OK.

5. New windows pops up, Select Application Settins

6. Select DLL AND select Empty Project

7. Select Finish

a new project pops up in the workspace with class name
(ElasticPPCPP)

8. Right click on source files, select add Existing Item.

9. browse to the class file (should be up 1 directory, select it
(elasticPPcPP.cpp)

10.Right click on heared files, select add existing item.

11. browse to header file, select it (elasticOOCPP.h)

12. right click on Project (ElasticPPCPP), select build.

It fails in compilation, as cannot find file elementAPI.h

13. right click on Project (ElasticPPCPP), select Properties.
14. select c/C++ folder icon

15. In Configuration pull down menu, select all Configurations
16. Click 3 dots to right of Additional Include Directories
17. In window that pops up, select folder

18. add to line ..\..\core (this directory contains the
elementAPI.h file).

1.9. select oOk.

20 right click on project (ElasticPPCPP), select build

It fails in Linking, a lot of unresolved external symbols.
21. Right click on source files, select add Existing Item.
22. browse to the core directory (should be 1 directory up)
23. select all the .cpp files here

24. right click on Project (ElasticPPCPP), select build.

-rrllll7
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File Edit View Debug Team Data Tools Test Window Help

Page - Microsoft Visual Studio Academic

iR S P& aB[9 -0 -85 | | xmi

: e L W, By
ﬁ’ o |3‘§ =

Solution Explo.=r I Ol Start Page X

'

. Micrgsolt® :
stual Studio 2010 Professional

Get Started Guidance and Resources Latest N¢

+_
& ,| Connect To Team Foundation Server

Welcome  Windows

1 W\ New Project...

i P {"1) File -> New ->Project

Recent Projects

fa—

= FElactirDDrnn
Close page after project load
Show page on startup

Output

Web Cloud Office SharePc

What's New in Visual Studi
Learn about the new features ir

Visual Studio 2010 Overview
What's New in .NET Framework
What's New in Visual C++
Customize the Visual Studio St:

Show output from: | File Generation v| ’ 3 I 3 D | =74 I =




-

New Project ‘ @ X |

Recent Templates [.NET Framework 4

Installed Templates

v J Sort by: [Default ] [ Search Installed Templates

Win32 Console Application Visual C++ Tape: Visval G

4 \isual C++
ATL
CLR
General
MFC
Test
Win32

Intel(R) Visua n 4. SEIECt Win32 PrOjeCt

Other Languages

A project for creating a Win32
application, console application, DLL, or

3| Win32 Project Visual C oy static library

Other Project Types

Database

Test Projects 3. Select Win32

Online Templates

I 1. Give DLL name ElasticPPcpp | I
: - | 5. Select OK |
2. Give Location | .
Name: ElasticPPcpp

Location: C:\Users\PEER Center\DEVELOPER\material\cpp\ v

Solution name: ElasticPPcpp /| Create directory fofl solution
|| Add to source contlol




la

Win32 Application Wizard - ElasticPPcpp L@ﬁi

T

Welcome to the Win32 Application Wizard

Overview These are the current project settings:

Application Settings ® Windows application

Click Finish from any window to accept the current settings.

After you create the project, see the project's readme.bxt file for information about the project
features and files that are generated.

Select Application Settings

orevious Next > H Finish ][ Cancel
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Win32 Application Wizard - ElasticPPcpp

2 =k

Application Settings

Application type:

Overview

Application Settings ) Windows application
) Console application

@ DLL

Additional options:
Empty project

Add common header files for:

1. Select DLL |

2. Select DLL |

3. Select Finish

< Previous

Finish ][ Cancel ]




Add Files To Project

File Edit View Project Build Debug Team Data Tools Test Window Help

il S A | % a9 - -S| b |Debug ~| | Win32 - | [# |Umfpack
P T e e |3k B

Solution Explorer | B

=i
. Solution 'ElasticPPcpp’ (1 project
4 71 ElasticPPcpp

=4 External Dependencies

L Header Files

1 Resource Files

.1 Source Files

Right Click on Source Files

Select Add Existing

Navigate to DEVELOPER/material/cpp directory
Select the ElasticPPcpp.cpp and .h file

Select Add




o® ElasticPPcpp - Microsoft Visual Studio Academic

File Edit View Project Build Debug Team Data Tools
Pl (3 a | ¥ UN .| b |Debug «| [ Win32
: *l"' *II') 4

. ﬁ on ondgs %, 1 g}o = —

Solution Explorer
(2 |
.4 Solution 'ElasticPPcpp’ (1 project
4 71 ElasticPPcpp
> @4 External Dependencies
d Header Files
d Resource Files
4 |7 Source Files
¢ ElasticPPcpp.cpp
] ElasticPPcpp.h

Test Window Help

-1 % [Umfp

vqx

1) Select Build -> Solution



File Edit View Project Build Debug Team Data Tools Test Window Help
Pl (S | % A9 - -8 -G b [Debug  -|[win32 -/ | (#® |umfpack R RReRE -
PN Ny (B

Solution Explorer

iy [
-4 Solution 'ElasticPPcpp’ (1 project
4 [7] ElasticPPcpp

4 External Dep®

3 Header Files

[ Resource Files

4 |7 Source Files

A ElasticPPcpp.cpp Right Click on ElasticPPcpp Project

n] ElasticPPcpp.h

Select Properties
Select C/C++

Output
Show output from: | Build 'J ‘ 3 | & D \ = | =

1>PrepareForBuild:
1> Creating directory "C:\Users\PEER Center\DEVELOPER\material\cpp\ElasticPPcpp\Debug\".

1>InitializeBuildStatus:

1> Creating "Debug\ElasticPPcpp.unsuccessfulbuild"” because "AlwaysCreate" was specified.

1>C1Compile:

1> ElasticPPcpp.cpp

1>c:\users\peer center\developer\materiall\cpp\elasticppcpp.cpp(32): fatal error (C1883: Cannot open include file: ‘elementAPI.h': No such
1>

1>Build FAILED.

: IT FAILS!
1>Time Elapsed ©00:00:00.55

========== Build: @ succeeded, 1 failed, @ up-to-date, @ skipped ==========




ElasticPPcpp Prope

Configuration: [All Configurations

» Common Properti
4 Configuration Propertie:

General
Debugging

Intel Performance Lit

VC++ Directories

a C/C++

General \
Optimization

Preprocessor

Code Generation

Language

Precompiled Heac

Output Files

Browse Informatic

Advanced
Command Line

» Linker

» Manifest Tool
> XML Document Gene
> Browse Information
» Build Events

» Custom Build Step

1] ‘ 3

4. Include core in additional include directories

v | Platform: [Active(Win32)

o/

v] [ Configuration Manager... l

Additional Include Directories

Resolve #using

References

A\ \core

3. Select All Configuarations from Pull Down Menu

Warning Level

Treat Warnings As Errors

Multi-processor Compilation
Use Unicode For Assembler Listing

1.
2.

Select C/C++
Select General

‘ Addifionai include Directories

Level3 (/W3)

No (/WX-)

| Specifies one or more directories to add to the include path; separate with semi-colons if more than one.

(/1path])

] l Cancel




|28 ElasticPPcpp - Microsoft Visual Studio Academic

File Edit View Project Build Debug Team Data Tools Test Window Help

il (S 8B - - E | b [Debug - [winn2 -/ || |Umfpack e e i Bee Rl ) fom R
PNy |3k B

Solution Explorer

a || R

-4 Solution 'ElasticPPcpp’ (1 project
4 71 ElasticPPcpp

=4 External Dependencies

[ Header Files

[ Resource Files

ouere 1) Select Build -> Solution

Output

Show output from: | Build ‘ ‘kJ _4 =X j
1>tlasticPPcpp.obj : error LNK2001: unresolved external symbol ° publlc: virtual 1nt __thiscall MovableUbject::setVariable(char const *,class Intormation &
1>ElasticPPcpp.obj : error LNK2001: unresolved external symbol “public: virtual int _ thiscall MovableObject::getVariable(char const *,class Information &
1>ElasticPPcpp.obj : error LNK2019: unresolved external symbol “public: virtual _ thiscall UniaxialMaterial::~UniaxialMaterial(void)" (??1UniaxialMaterial
1>ElasticPPcpp.obj : error LNK2019: unresolved external symbol “public: int _ thiscall MovableObject::getDbTag(void)const " (?getDbTag@MovableObject@@QBEH
1>ElasticPPcpp.obj : error LNK2019: unresolved external symbol "public: _ thiscall Vector::Vector(int)" (2?0Vector@@QAE@H@Z) referenced in function "publi
1>ElasticPPcpp.obj : error LNK2019: unresolved external symbol “public: _ thiscall Vector::~Vector(void)" (??1Vector@@QAE@XZ) referenced in function "void
1>ElasticPPcpp.obj : error LNK2019: unresolved external symbol “protected: void _ thiscall TaggedObject::setTag(int)" (?setTag@TaggedObject@@IAEXH@Z) refe
1>C:\Users\PEER Center\DEVELOPER\material\cpp\ElasticPPcpp\Debug\ElasticPPcpp.dll : fatal error LNK1120: 31 unresolved externals

1>

1>Build FAILED.

1>

1>Time Elapsed ©00:00:00.27

========== Build: @ succeeded, 1 failed, @ up-to-date, @ skipped ==========

IT FAILS!




ElasticPPcpp - Microsoft Visual Studi : . v
File Edit View Project Build Debug Team Data Tools Test Window Help
Pl S | % a9 - - L-E | b |Debug - || Win32 - (3 | xmi R RRRE
-IEETArE ]

v q X

Solution Explorer
2|28
-4 Solution 'ElasticPPcpp’ (1 project
4[] ElasticPPcpp
a4 External Dependencies
[ d Header Files

[ Resource Files
4 |7 Source Files

—— N
KRGl | * fmk » DEVELOPER » core v |4 | Searchcore 9]

Organize v New folder = O &

. Documents *  Name Date modified Type Size

&3 ElafdcPPCcDD. 4. Music
=] ElafQePcpp.cpp ; & Analysis 1/20/2012 413PM  C++ Source 3K
1) El8tePPcpp.h “. Pictures : ) ,
8 vid @] Analysis 1/20/2012 413PM  C/C++ Header 3
ideos :
: & AnalysisModel 1/20/2012 413 PM  C++ Source 17K
= lﬁ AnalysisModel 1/20/2012 4:13 PM C/C++ Header 6K
+% Homegroup _. ) ; .
& ArrayOfTaggedObjects 1/20/2012 413 PM  C++ Source 12K
0] ArrayOfTaggedObjects 1/20/2012 413 PM  C/C++ Header 4K
‘& Computer : § ‘
E & ArrayOfTaggedObjectsiter 1/20/2012 413 PM  C++ Source 4K
& BOOTCAMP (C) 3 s
] | gJ ArrayOfTaggedObjectslter 1/20/2012 413 PM  C/C++ Header 3K
~ Macintosh HD (E:
ijﬂ BinaryFileStream 1/20/2012 413 PM  C++ Source 18K
& | BinaryFileStream 1/20/2012 4:13 PM C/C++ Header 4K~
Output € Network e ‘qj 2 = . : : :
1. Right Click on Source Files - [ Al Files (=) v
2, Select Add Existing [ add || [ concer |
3. Navigate to DEVELOPER/core directory .
- 1SCa vector:vector(1n F7oVector@@UAERAE eTe
4. SeIECt the A" -Cpp and 'h ﬁle iscall Vector::~Vector(void)" (2?1Vector@@QAE@XZ) ref
5. Select Add bid _ thiscall TaggedObject::setTag(int)" (?setTag@Ts
b.d1ll : fatal error LNK112@: 3@ unresolved externals

1>
1>Time Elapsed ©00:00:00.74
========== Build: @ succeeded, 1 failed, @ up-to-date, @ skipped ==========



'ticPPcpp—ﬁlcrosoft' isual Studio =
File Edit View Project Build Debug Team Data Tools Test Window Help

i - S Ao %R - - L5 b Debug -| | Win32 - | xmi -
EETE S 2

Solution Explorer v 1 X

a| S

-d Solution 'ElasticPPcpp’ (1 proj 4
4 [J] ElasticPPcpp
@ External Dependencies
[d Header Files
1 Resource Files
4 |7 Source Files
¢4 Analysis.cpp
1] Analysis.h
¢ AnalysisModel.cpp
(] AnalysisModel.h
&4 ArrayOfTaggedObjec
n] ArrayOfTaggedObjec
¢ ArrayOfTaggedObjec
(0] ArrayOfTaggedObje
¢4 BinaryFileStream.cpp
1] BinaryFileStream.h
¢ Channel.cpp
(1] Channel.h
] classTags.h Output
1] ColorMap.h
¢ ConstraintHandler.cp
1] ConstraintHandler.h

11

e
1>tlasticPPcpp.obj : error LNK20Y1: unresolved external symbol ‘public: virtual double __thiscall UniaxialM
1>ElasticPPcpp.obj : error LNK2001: unresolved external symbol "public: virtual double _ thiscall UniaxialM

Show output from: | Build ’

1) CrdTransfh 1>ElasticPPcpp.obj : error LNK20@1: unresolved external symbol "public: virtual int _ thiscall UniaxialMate
¢ DataFileStream.cpp 1>ElasticPPcpp.obj : error LNK2019: unresolved external symbol "public: virtual _ thiscall UniaxialMaterial
] DataFileStream.h 1>ElasticPPcpp.obj : error LNK2019: unresolved external symbol "public: int _ thiscall MovableObject::getDb
¢4 DOF_Group.cpp 1>ElasticPPcpp.obj : error LNK2019: unresolved external symbol "public: _ thiscall Vector::Vector(int)" ()>
| n] DOF_Group.h 1>ElasticPPcpp.obj : error LNK2019: unresolved external symbol "protected: void _ thiscall TaggedObject::
| e DOF_Grplter.cpp 1>C:\Users\PEER Center\DEVELOPER\material\cpp\ElasticPPcpp\Debug\ElasticPPcpp.dll : fatal error LNK1120: 52
1>

i ] DOF_Grplter.h

| T i F .
¢ Domain.cpp i:Bulld ATLED
| i
| ) Domainh 1>Time Elapsed 00:00:01.51
G
2] DomainComponent. ========== Build: @ succeeded, 1 failed, @ up-to-date, @ skipped ==========

7] DomainComponent. ~
<l T » « | "




File Edit View Project Build Debug Team Data Tools Test Window Help
e AR A = N

<[

s L

sticPPcpp - Microsoft V

ou" on‘u %,
Solution Explorer v o X

=

| Source Files £

SN R e R ] lReIease v‘ ‘Win32 th_’) |Xml - lcj ol Rz Gl SN

e

i}°§':

¢4 Analysis.cpp

] Analysis.h

¢4 AnalysisModel.cpp

] AnalysisModel.h

9 ArrayOfTaggedObjeq

] ArrayOfTaggedObje

¢ ArrayOfTaggedObje¢ |

] ArrayOfTaggedObjec

¢ BinaryFileStream.cpp

] BinaryFileStream.h

¢ Channel.cpp

1] Channel.h

] classTags.h

1] ColorMap.h

¢ ConstraintHandler.cp

1] ConstraintHandler.h

] CrdTransf.h

¢ DataFileStream.cpp Output

] DataFileStream.h

¢ DOF_Group.cpp

1] DOF_Group.h

¢ DOF_Grplter.cpp

0] DOF_Grplter.h

¢ Domain.cpp

"] Domain.h

¢ DomainComponent.c

"] DomainComponent.

"] DomainDecompositi

¢ ElasticPPcpp.cpp

1n] ElasticPPcpp.h

¢ Element.cpp

] Elementh -
1 " P

c. Br. BIR T

1. Select Build - Solution

m

Show output from: | Build R l@D | x|=

1>Link:

1> Creating library C:\Users\PEER Center\DEVELOPER\material\cpp\ElasticPPcpp\Release\ElasticPPcpp.lib and object C:\Users
1> Generating code

1> Finished generating code

1> ElasticPPcpp.vexproj -> C:\Users\PEER Center\DEVELOPER\material\cpp\ElasticPPcpp\Release\ElasticPPcpp.dll
1>FinalizeBuildStatus:

1> Deleting file "Release\ElasticPPcpp.unsuccessfulbuild”.
1> Touching "Release\ElasticPPcpp.lastbuildstate”.

1>

1>Build succeeded.

1>

1>Time Elapsed ©0:00:13.51

========== Build: 1 succeeded, @ failed, @ up-to-date, @ skipped

< | n
B Code Definition Window [EIKeliisiis




Copy ElasticPPcpp.dll from
location into current directory

@le » fmk » DEVELOPER » material » cpp »

Organize v .| Open Include in library v Share with v Burn New folder
4 Eavorites = Name ’ Date modified Type Size
Ml Desktop @ CElasticPPcpp 1/20/2012 5:00 PM  File folder
'+ Downloads # ElasticPPcpp 1/20/2012 413 PM  C++ Source 7 KB
<» Recent Places @ CElasticPPcpp.dll 1/20/2012 457 PM  Application extens.. 729 KB
@] ElasticPPcpp 1/20/2012 413PM  C/C++ Header 4 KB
4 ] Libraries @ Example 1/20/20125:01 PM  OUT File 1KB
*» Documents = & examplel 1/20/2012 413PM  TCLFile 2KB
& Music @ Makefile 1/20/2012 4:13PM  File 1KB

Now run Example



Command Prompt

icrosoft Windows [Uersion 6.1.760811
opyright <{c> 280? Microsoft Corporation. All rights reserved.

:\Users\PEER Center>cd DEUELOPER

:\Users\PEER Center\DEUELOPER>cd material

:\Users\PEER Center\DEUELOPER\material>cd cpp

:\Users\PEER Center\DEUELOPER\materialNcpp>OpenSees Examplel.tcl

OpenSees — Open System For Earthquake Engineering Simulation
Pacific Earthgquake Engineering Research Center — 2.3.2

(c> Copyright 19299.2008 The Regents of the University of California
All Rights Reserved
(Copyright and Disclaimer» @ http://uuww.berkeley.edu/OpenSees/copyright._html)

lasticPPcpp unaxial material — Written by fmk UC Berkeley Copyright 268688 — Use
t your Ouwn Peril

Node: 4
Coordinates = 72 96
Disps: 8.5360093 —-68.177894
Uelocities 809
unbalanced Load: 1688 -58
ID : 8 1

lement: 1 type: Truss iNode: 1 jNode: 4 Area: 108 Mass/Length: @
strain: 08.80146451 axial load: 380
unbalanced load: —-18 —-24 18 24
Material: ElasticPPcpp tag: 1

E: 3060008

ep: B.800464506

stress: 3 tangent: @

lement: 2 type: Truss iNode: 2 jNode: 4 Area: 5 Mass/Length: @
strain: —60.808383642 axial load: —-15
unbalanced load: -9 12 9 —-12
Material: ElasticPPcpp tag: 1

E: 3060008

ep: —B.00283642

stress: —3 tangent: B8

lement: 3 type: Truss iNode: 3 jNode: 4 Area: 5 Mass/Length: @
strain: —-68.808368743 axial load: —-15
unbalanced load: —-168.60866 10.6866 18.6866 —168.6066
Material: ElasticPPcpp tag: 1

E: 3080868

ep: —B.80268743

stress: —3 tangent: B8

:\Users\PEER Center\DEUELOPER\materiall\c




What Follows are the Steps
required to Build
ElasticPPcpp.so on a Linux
Machine with gcc installed

NOTE: We Will use
NEEShub
for this demonstration
(http://Inees.org)



3 Simple Steps!

1. Download code

svn co svn://opensees.berkeley.edu/usr/local/svn/OpenSees/trunk/OpenSees/Developer Developer

2. cd DEVELOPER/material/cpp

3. type make

iIf you type Is you should see the .so and you
Can test it using >OpenSees example1.tcl

NOTE: mac users must have xcode installed and
must open DEVELOPER/Makefile.def and switch
comments on lines 1 and 2 before step 3.



1: Download Source Code

M NEES - Resources: Tools: Works...
€ 9 | IN https;//nees.org/tools/workspace/

startnew

ZM Shopping @ Games . Travel @ Amazon e eBay Facebook M Tw

George E. Brown, Jr. Network for Earthquake Engineering Simulation

About NEES  Tools & Resources  Learning & Outreach ~ Project Warehouse  Simulation  Sites = Collaborate

You are here: Home » Resources » Tools » Workspace » Session: 33391 "Workspace”™

Workspace

fmkBNEES:™$ svn co svni//opensees,berkeley,edususr/local /svn/OpenSees/trunk /DEVELOPER DEVELOPER |




2/3: cd to Directory & Type make

M NEES - Resources: Tools: Works...
€ » | N nttps;//nees.org/tools/workspace/session/33391

startnew T ' 0 o x"*lﬁ- Im lH ZM Shopping ‘ Games .- Travel @ Amazon Y eBay

DEVELOPER/material /cpp/examplel, tcl

DEVELOPER/material /fortran

DEVELOPER/material /fortran/material Types,f
DEVELOPER/material /fortran/materialAPI,f
DEVELOPER/material/fortran/Makefile

DEVELOPER/material /fortran/examplel,tcl
DEVELOPER/material /fortran/elasticPPf,f
DEVELOPER/material /Makefile

Checked out revision 4773,

fmk@NEES:"™$

fmk@NEES:"™$

fmkBNEES:™$ cd DEVELOPER/material/cpp
fmkBNEES: "~ /DEVELOPER/material /cpp$ ls

ElasticPPcpp.cpp ElasticPPocpp.h  Makefile examplel.tcl
fmk@NEES: " /DEVELOPER/material /cpp$ make

g++ -fPIC -I,./core -1,./../core —-g -c -llall ElasticPPcpp.cpp
g++ -shared -ll1,-soname,ElasticPPcpp,so -o ElasticPPcpp,so ElasticPPcpp,o -lc
fmk@NEES: " /DEVELOPER/material/cpp$ ls

ElasticPPcpp,cpp ElasticPPcpp,h ElasticPPcpp,o ElasticPPcpp.so Makefile examplel,tcl
fmk@BNEES: "~ /DEVELOPER/material /cpp$
fmkBNEES: "~ /DEVELOPER/material /cpp$
fmkBNEES: " /DEVELOPER/material /cpp$

CulLQMCCC N JMCUCT NDCD dai cde el w1 e
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startnew

L

”~

## Shopping 3 Games w:” Travel @ Amazon oY eBay Facebol

Color xterm
g++ -shared -l/1,-soname,ElasticPPcpp,so -0 ElasticPPcpp,so ElasticPPcpp.o -lc
fmk@MNEES: " /DEVELOPER/material /cpp$ ls

ElasticPPcpp.cpp ElasticPPcpp.h ElasticPPcpp.o ElasticPPcpp.so Makefile examplel,tcl
fmk@NEES:”/DEVELOPER/material/cpp$ /apps/openseesbuild/osg/bin/OpenSees examplel,tcl

OpenSees -- Open System For Earthquake Engineering Simulation
Pacific Earthquake Engineering Research Center -- 2,3,2

{c) Copyright 1999,2000 The Regents of the University of California
All Rights Reserved
{Copyright and Disclaimer @ http://www,berkeley,edu/OpenSees/copyright html)

ElasticPPcpp unaxial material - Written by fmk UC Berkeley Copyright 2008 - Use at your Own Peril

Node: 4
Coordinates : 72 96
Disps: 0,530093 -0,177894
Velocities $ 00
unbalanced Load: 100 -50
ID:01

Element: 1 type: Truss iMode: 1 jNode: 4 Area: 10 Mass/Length: 0
straing 0,00146451 axial load: 30
unbalanced load: -18 -24 18 24
Material: ElasticPPcpp tag: 1
E: 3000
ep: 0,000464506
stress: 3 tangent: 0

Element: 2 type: Truss iNode: 2 jNode: 4 Area: 5 Mass/Length: 0
straing -0,00383642 axial load: -15
unbalanced load: -9 12 9 -12

Mot mininls Cland s ~ADDAmm +ome 1



NEXT SEMINAR

* Feb 2012, Topic EITHER be High
Performance Computing and OpenSees
or How To Model Soil-Structure
Interaction.

» We will again be using NEEShub for the
demonstration. So get an account if you
don’t have one! It’s free to everyone.



